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HD-WP-4K-401-C: 
4K Multi-Window Video Processor 
with HDBaseT® and HDMI® Outputs 

Introduction 
The Crestron® HD-WP-4K-401-C enables the simultaneous display of up to four video 
sources on a single HD, Ultra HD, or 4K display. Parallel HDMI® and HDBaseT® outputs 
provide flexible connectivity for the HDMI display and other equipment. Input sources up to 
4K are supported via four HDMI inputs. Fully automatic operation and out-of-the-box 
functionality enable use without a control system, while enhanced operation and custom 
functionality can be attained through integration with a control system. 

Video windowing enhances the presentation and collaboration capabilities of any meeting 
space, allowing multiple presentation sources to be connected and displayed together on 
screen. The ability to connect up to four Crestron Connect It™ cable caddies  
(TT-100 Series) directly to the HD-WP-4K-401-C affords a perfect multi-window 
collaboration solution for huddle rooms and classrooms.  

Easy setup and configuration of the HD-WP-4K-401-C is enabled using a web browser or 
the front panel controls. This guide provides information about the out-of-the box 
functionality of the HD-WP-4K-401-C as well as configuration of the HD-WP-4K-401-C 
using the web interface and the front panel OLED display. For installation information, refer 
to the HD-WP-4K-401-C DO Guide (Doc.7900) at www.crestron.com/manuals. 

Using the Out-of-the-Box Functionality 
Out-of-the box functionality automatically allows the simultaneous display of all connected 
audio/video sources on an HDMI display without the need for additional programming or 
configuration. If one source is connected, one full-screen window appears on the display.  
If two sources are connected, two side-by-side windows of equal size appear on the display 
and are vertically centered. If three sources are connected, three windows of equal size 
appear on the display (two side-by-side windows above one centered window). If four 
sources are connected, four windows of equal size appear on the display. The following 
illustration shows the one-, two-, three-, and four-window configurations. 
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Window Configurations Using Out-of-the-Box Functionality 

 

NOTE:  Audio is transmitted only when a single full-screen image is displayed in a single 
window. If multiple windows are displayed, the audio from all sources is muted. 

To display sources using out-of-the-box functionality, do the following: 

1. Connect up to two HDMI displays to the HD-WP-4K-401-C as required for the 
application. One HDMI display connects to the HDMI output of the  
HD-WP-4K-401-C. The other HDMI display connects to the HDBT (HDBaseT) 
output of the HD-WP-4K-401-C via a DM 8G+® receiver, DigitalMedia™ switcher, 
or DM-DGE-200-C Digital Graphics Engine. The HDBT output can also connect 
directly to any display device equipped with an HDBaseT input.  

2. Connect up to four HDMI sources to the HDMI inputs of the HD-WP-4K-401-C.  
All connected sources appear on the display in the corresponding window 
configuration.  

NOTE:  If both the HDMI and HDBT outputs are connected, the HDBT output 
display mirrors the HDMI output display. 

3. (Optional) Connect up to four Crestron Connect It cable caddies to the USB input 
ports of the HD-WP-4K-401-C.  Press a button on a cable caddy while the LED is 
blue to display the associated source as a full-screen window on the display.  
Press the button again while the LED is green to allow the display to return to the 
previous configuration (two, three, or four windows). 
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Using the Web Interface 
Built-in web pages of the HD-WP-4K-401-C allow video windowing, on-screen display, 
input, output, network, and device settings to be configured. In addition, status information 
about the HD-WP-4K-401-C can be viewed.  

Accessing the Web Interface 
The following table lists various operating systems and the corresponding web browsers 
that are supported by the HD-WP-4K-401-C web interface. 

Operating System and Supported Web Browsers for the HD-WP-4K-401-C 

OPERATING SYSTEM SUPPORTED WEB BROWSERS 

Windows® operating system Internet Explorer® web browser, version 9 and later 
Chrome™ web browser, version 31 and later 
Firefox®  web browser, version 31 and later 

macOS™ operating system 
 
 

Safari® web browser, version 6 and later 
Chrome web browser, version 31 and later 
Firefox web browser, version 31 and later 

iOS® operating system Safari web browser, version 6 and later 
Chrome web browser, version 31 and later 

Android™ operating system Chrome web browser, version 31 and later 

To access the web interface, do either of the following: 

• Open a web browser directly. Refer to "Opening a Web Browser Directly" for 
additional information. 

• Open a web browser within the Crestron Toolbox™ application. Refer to "Opening 
a Web Browser within the Crestron Toolbox Application" for additional information. 

Opening a Web Browser Directly 
To access the web interface by opening a web browser directly, do the following: 

1. Note the IP address that appears on the front panel OLED display. 

NOTE:  After power is applied to the HD-WP-4K-401-C, the IP address appears on 
the front panel OLED display. 

2. Open a web browser. 

3. Go to the IP address of the HD-WP-4K-401-C. 

The Login page opens. For login information, refer to "Logging In to the 
HD-WP-4K-401-C" on the following page. 

Opening a Web Browser within the Crestron Toolbox Application 
To access the user interface by opening a web browser within the Crestron Toolbox 
application, do the following: 

1. Open the Crestron Toolbox application. 

2. From the Tools menu, select Device Discovery Tool. 
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NOTE:  You can also access the Device Discovery Tool by clicking the Device 
Discovery Tool button ( ) in the toolbar. 

NOTE:  The security software running on the computer may send a program alert 
regarding the attempt of the Crestron Toolbox application to connect to the 
network. Allow the connection so that the Device Discovery Tool can be used. 

3. From the device list on the left-hand side of the screen, double-click
HD-WP-4K-401-C.

A browser window opens, and then the user name and password dialog box
opens, allowing login to the HD-WP-4K-401-C. For login information, refer to
"Logging In to the HD-WP-4K-401-C" below.

Logging In to the HD-WP-4K-401-C 
The user name and password dialog box allows login to the HD-WP-4K-401-C. 

NOTE:  Depending on the web browser being used, the appearance of the user name and 
password dialog box may vary from the dialog box shown below. 

User Name and Password Dialog Box 

To log in to the HD-WP-4K-401-C, do the following: 

1. Enter the user name and password. The default user name is admin, and the
default password is admin.

NOTE:  The user name and password are case sensitive. 

NOTE:  For enhanced security, it is recommended that the user name and 
password be changed. To change the user name and password using the web 
interface, refer to "Changing the Username and Password" on page 24.  

NOTE:  If the user name and password are changed and the factory default 
settings are later restored, the user name and password will revert to the default 
setting, which is admin. 

2. Click Log In.

The Status page opens. For an overview of the web interface, refer to "Navigating
the Web Interface" on the following page.
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Navigating the Web Interface 
The web interface provides a navigation bar and built-in web pages of the 
HD-WP-4K-401-C. 

Web Interface (Sample Status Page of HD-WP-4K-401-C Shown) 

The navigation bar provides access to the web pages as follows: 

• Clicking Status accesses the Status page, which provides general information
about the HD-WP-4K-401-C as well as network-related and control system
information. For additional information, refer to "Viewing Status Information" on the
following page.

• Clicking Windowing accesses the Windowing page, which allows the layout of up
to four video windows to be configured. For additional information, refer to
"Configuring Windowing Settings" on page 7.

• Clicking On-Screen Display accesses the On-Screen Display page, which allows
text or an image—or both—to be overlaid on the connected display. For additional
information, refer to "Configuring On-Screen Display Settings" on page 9.

• Clicking Input accesses the Input page, which allows the desired EDID to be sent
to the inputs. For additional information, refer to "Configuring Input Settings" on
page 10.

• Clicking Output accesses the Output page, which allows the output resolution to
be set as well as analog audio settings. For additional information, refer to
"Configuring Output Settings" on page 15.

• Clicking Network accesses the Network page, which allows network settings such
as hostname and DHCP (Dynamic Host Configuration Protocol) mode to be set.
For additional information, refer to "Configuring Network Settings" on page 21.

• Clicking Device accesses the Device page, which allows changes to username and
password settings and also controls various device functions. For additional
information, refer to "Configuring Device Settings" on page 23.
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Viewing Status Information 
General information, such as model name, serial number, and firmware version of the  
HD-WP-4K-401-C, can be viewed. The current network settings as well as control system 
connection settings can also be viewed. 

To view status information, do the following: In the navigation bar, click Status.  
The Status page opens. 

NOTE:  The Status page opens after logging in to the HD-WP-4K-401-C. 

Sample Status Page 

 

The Status page displays the following information about the HD-WP-4K-401-C: 

• General information, which consists of the following: 

o Model (HD-WP-4K-401-C) 

o Serial Number 

o Firmware Version 

• Network-related information, which consists of the following: 

o Hostname 

NOTE:  The default hostname is HDWP401C-xxxxxx, where xxxxxx 
consists of the last six characters (excluding punctuation) of the MAC 
address of the device. 

o IP Address 

o Subnet Mask 

o Default Gateway 

o MAC Address 
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• Control system connection information, which consists of the following: 

o Address of the control system  

o IP ID of the HD-WP-4K-401-C 

o Port number of the HD-WP-4K-401-C 

NOTE:  The default port number is 41794. 

o Status (Online or Offline) 

Configuring Windowing Settings 
Video windowing allows up to four video sources to be displayed simultaneously on a single 
display.  

To configure video windowing, do the following: 

1. In the navigation bar, click Windowing. The Windowing page opens. 

Windowing Page 

 

2. In the Layout section of the screen, select one of the following windowing modes: 

• Automatic:  (Default setting) Displays the detected inputs as follows: 

o Displays four detected inputs as a quad view consisting of four  
equal-sized windows (two side-by-side windows above two  
side-by-side windows) 

o Displays three detected inputs as three equal-sized windows  
(two side-by-side windows above one centered window) 
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o Displays two detected inputs as two equal-sized and vertically 
centered windows 

o Displays one detected input as a full-screen image 

• Full Screen:  Displays any single input as a full-screen image 

NOTE:  Inputs 1 and 2 allow sources with resolutions up to DCI 4K to be 
displayed at the full resolution when in full-screen mode as long as the 
resolution is supported by the display device. Inputs 3 and 4 accept 
sources with a resolution up to DCI 4K; however, the full-screen output 
resolution for inputs 3 and 4 is automatically downscaled to 1080p.  

• Picture-in-Picture (PIP):  Displays any single input as a full-screen image 
with any other input as a scalable inset window that can be positioned as 
desired (refer to step 5 below for information about PIP options) 

• Side-by-Side:  Displays any two inputs as two equal-sized and vertically 
centered windows 

• Quad View:  Displays four inputs as four equal-sized windows (two side-
by-side windows above two side-by-side windows) 

3. (Applicable to all Layout modes except Automatic mode) In the Source Selection 
section of the page, select the desired source to be displayed in a window as 
applicable to the windowing layout. 

4. In the Audio Selection drop-down list, select the source whose audio is to be 
unmuted or select Auto (default setting). If Auto is selected, audio is transmitted 
only when a single full-screen image is displayed in a single window or when the 
layout is in PIP mode. If multiple windows are displayed, the audio from all sources 
is muted. 

5. (Applicable only to Picture-in-Picture layout) In the PIP Options section of the 
page, do the following: 

a. In the Location drop-down list, select one of the following options to 
position the smaller window within the larger window:  Upper Left, Center 
Left, Lower Left, Upper Right, Center Right, Lower Right, or Custom. 
The default setting is Upper Left. 

If Custom is selected, enter the X (horizontal) and Y (vertical) coordinates in 
pixels to position the smaller window, and then click the Save button. 

b. In the Size drop-down list, select one of the following options to set the 
size of the smaller window within the larger window:  Small (10%), 
Medium (20%), Large (30%), or Custom. The default setting is Medium 
(20%). 

If Custom is selected, enter the X (horizontal) and Y (vertical) coordinates in 
pixels to set the size of the smaller window, and then click the Save button. 
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6. In the Window Titles section, do the following: 

a. Enable or disable window titles by clicking the Enabled or Disabled radio 
button, respectively. If enabled, the input name is displayed over the 
window. By default, the Enabled radio button is selected. 

b. (Applicable only when Window Titles is set to Enabled) Do the following: 

i. In the Location drop-down list, select one of the following options to 
position window titles:  Upper Left, Center Left, Lower Left, Upper 
Right, Center Right, or Lower Right. The default setting is  
Upper Left. 

ii. In the Font Size drop-down list, select one of the following options 
to set the size of the window titles:  Small (10%), Medium (20%), 
Large (30%). The default setting is Medium (20%). 

Configuring On-Screen Display Settings 
A custom text label can be set for the HDMI video output. The text can be positioned at a 
designated location on screen to display a static label or a dynamic pop-up message sent 
from the control system. A custom photo or logo image can also be uploaded to appear at 
a designated location on the screen. 

To configure on-screen display settings, do the following:  In the navigation bar, click 
On-Screen Display. The On-Screen Display page opens.  

On-Screen Display 

 

Refer to the following sections for information about text overlay and image overlay 
configuration information. 

Configuring Text Overlay Settings 
In the Text Overlay section of the On-Screen Display page, configure text overlay settings 
by doing the following: 

1. Enable text overlay by clicking the Enable radio button if it is not already selected. 
By default, the Disable radio button is selected, preventing text from being overlaid 
on the display device.  

2. In the Text to display text box, enter the desired text, and then click the Save 
button. 
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3. In the Location drop-down list, select one of the following options to position the 
text on the display device:  Upper Left, Center Left, Lower Left, Upper Right, 
Center Right, Lower Right, or Custom. The default setting is Upper Left. 

If Custom is selected, enter the X (horizontal) and Y (vertical) coordinates in pixels 
to position the text on the display, and then click the Save button. 

4. In the Font Size drop-down list, select one of the following:  Small (10%), Medium 
(20%), and Large (30%). The default setting is Medium (20%).     

Configuring Image Overlay Settings  

NOTE:  The image file to be uploaded for on-screen display must be an *.bmp file, have a 
maximum resolution of 1920 x 1080 pixels, and be an 8-bit color image.  

In the Image Overlay section of the On-Screen Display page, configure image overlay 
settings by doing the following:   

1. Enable image overlay by clicking the Enable radio button if it is not already 
selected. By default, the Disable radio button is selected, preventing an image from 
being overlaid for on-screen display.  

2. Specify the image path type by selecting the Local or Remote radio button: 

• If the image is located on the hard drive of the device from which the  
HD-WP-4K-401-C web interface is accessed, select Local (default setting). 

• If the image is located on a device other than the local hard drive, select 
Remote. 

3. Specify the path to the image as follows:  

• If the image path type is set to Local, click the Browse button, navigate to 
the desired image file (*.bmp), and then click Open. The path and filename 
appear in the Path field. Click the Load button to upload the image file 
from the local device to the HD-WP-4K-401-C.  

• If the image path type is set to Remote, enter the URL (HTTP, HTTPS, or 
FTP) to access the image file (*.bmp) from a remote location. Click the 
Load button to upload the image file from the remote location to the  
HD-WP-4K-401-C. 

4. In the Location drop-down list, select one of the following options to position the 
image on the display device:  Upper Left, Center Left, Lower Left, Upper Right, 
Center Right, Lower Right, or Custom. The default setting is Upper Left. 

If Custom is selected, enter the X (horizontal) and Y (vertical) coordinates in pixels 
to position the image on the display device. 

Configuring Input Settings  
Configure inputs on the Input page or individually on the input-specific pages (Input 1, Input 
2, Input 3, and Input 4). The desired EDID can be selected and sent to the inputs. Built-in 
EDID files are available for selection, and custom EDID files can also be selected.  
In addition, inputs can be renamed and HDCP (High-bandwidth Digital Content Protection) 
support can be configured.  
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Configuring Inputs on the Input Page 
To configure inputs on the Input page, do the following: 

1. In the navigation bar, click Input. The Input page opens. 

Input Page 

 

2. Determine whether a built-in EDID file or a custom EDID file is to be sent to one or 
more inputs. If a custom EDID file is desired, continue with step 3; otherwise, skip 
step 3 and proceed to step 4. 

3. (For loading of custom EDID files only) In the Global EDID section of the page, load 
the desired custom EDID file by doing the following: 

a. Click the Browse button located to the right of the Load CEDID file field. 
Windows Explorer opens.  

b. Navigate to the desired EDID file (*.cedid), select the file, and then click the 
Open button.  

The selected EDID file appears in the Load CEDID file field. 

c. Click the Load button. A prompt appears asking for confirmation that the 
EDID file be uploaded to the input device. 

d. Click the OK button. The following occurs: 

• In the Global EDID section of the page, the custom EDID filename 
is added to the Send EDID to All inputs drop-down list. 

• In the Inputs section of the page, the custom EDID filename is 
added to the EDID drop-down lists. 
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4. Configure the inputs as follows: 

a. (Optional) In the Global EDID section of the page, globally apply the same 
EDID to all inputs simultaneously by doing the following: 

i. In the Send EDID to All inputs drop-down list, select the desired 
built-in EDID file or a custom EDID file. The built-in EDID files are as 
follows: 

 DM Default 4k 30Hz 2ch (Default setting) 
 DM Default 1080p60 2ch  
 Laptop 16x10 1280x800 2ch 
 Laptop 16x10 1920x1200 2ch 
 Laptop 16x9 1080p50 2ch 
 Laptop 16x9 1080p60 2ch 
 Laptop Widescreen 2ch 
 Consumer 4k 25Hz 3D HBR  
 Consumer 4k 30Hz 3D HBR  
 Consumer 1080p50 3D HBR 
 Consumer 1080p50 HBR 
 Consumer 1080p60 3D HBR 
 Consumer 1080p60 HBR 
 Consumer 720p50 HBR 
 Consumer 720p60 HBR 
 Copy HDMI Output 
 Copy HDBT Output 

NOTE:  Selecting Copy HDMI Output or Copy HDBT Output 
copies the EDID from the output to all of the inputs. 

ii. Click the Apply to All button. The selected EDID is automatically 
sent to all inputs and appears in the EDID drop-down list for all 
inputs in the Inputs section of the page. 

b. In the Inputs section of the page, configure each input as follows: 

NOTE:  For each input, the Sync icon denotes whether a source is 
detected at the input. If a source is detected, the icon is green. If no source 
is detected, the icon is gray. 

i. In the Name text box, rename the input if desired. 

ii. If an EDID other than the Global EDID is to be assigned, select the 
desired EDID in the EDID drop-down list. 

iii. In the HDCP Support drop-down list, select HDCP 2.2, HDCP 
1.4, or Disabled. The default setting is HDCP 2.2. 

iv. Do one of the following: 

• For each input, click Save to save the current Name, 
EDID, and HDCP Support entries for the corresponding 
input. (Clicking Revert goes back to the previous settings 
without saving the current entries.) 

• Click Save All to save all unsaved entries. 
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c. In the TT-100 Support section of the page, select the TT-100 mode to 
determine how the HD-WP-4K-401-C is to interpret button presses on the 
connected Crestron Connect It cable caddies (TT-100 Series): 

• Quick Selection:  (Default setting) Pressing a button on a cable 
caddy while the LED is blue causes the input to be displayed in 
Full Screen windowing layout mode and changes the color of the 
LED to green. Pressing the button again while the LED is green 
causes the display to return to the previously selected windowing 
layout mode. For example, if the windowing layout mode is set to 
Quad View, pressing a button on a cable caddy while the LED is 
blue causes the input to be displayed in Full Screen windowing 
layout mode and changes the color of the LED to green. Pressing 
the button again while the LED is green causes the windowing 
layout mode to return the display to Quad View mode.  
(For information about windowing layout modes, refer to 
"Configuring Windowing Settings" on page 7.) 

• Standard:  Operates according to the SIMPL program (refer to the 
SIMPL Windows help file for information) 

To delete a custom EDID file, do the following in the Global EDID section of the page: 

NOTE:  Only custom EDID files can be deleted. Built-in EDID files cannot be deleted. 

1. In the Send EDID to All inputs drop-down list, select the custom EDID file to be 
deleted.  

2. Click the Delete button.  

The Delete EDID message box appears, asking for confirmation that the EDID file 
be removed.  

3. Click the Yes button to delete the EDID. 

The Delete EDID message box appears indicating success. 

4. Close the message box by clicking the X in the upper right-hand corner of the box.  

The custom EDID file is deleted from the Send EDID to All inputs drop-down list and also 
from each individual EDID drop-down list in the Inputs section of the page. 

Configuring Inputs on Input-Specific Pages 
To configure a specific input and to view detailed information about the selected EDID and 
about the input signal, do the following: 

1. In the navigation bar, click Input and then click the desired input:  Input 1, Input 2, 
Input 3, or Input 4. 

The Input page opens for the corresponding input.  
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Input-Specific Page (Sample Input 1 Page Shown) 

 

2. In the Input Settings section of the page, do the following: 

a. In the Name text box, rename the input if desired, and then click the Save 
button. 

b. In the HDCP Support drop-down list, select HDCP 2.2, HDCP 1.4, or 
Disabled. The default setting is HDCP 2.2. 

3. In the HID Control section of the page, observe the status of the connection of the 
Crestron Connect It cable caddy to the USB port on the HD-WP-4K-401-C: 

• A green icon indicates that a Crestron Connect It cable caddy is detected. 

• A gray icon indicates that a Crestron Connect It cable caddy is not 
detected. 

4. In the EDID section of the page, do the following: 

a. (Optional) Upload a custom EDID by doing the following: 

i. Click the Browse button located to the right of the Load CEDID 
file field. Windows Explorer opens. 

ii. Navigate to the desired EDID file (*.cedid), select the file, and then 
click the Open button. 

The selected EDID file appears in the Load CEDID file field. 

iii. Click the Apply EDID button. 

A prompt appears asking for confirmation that the EDID file be 
uploaded to the device.  

iv. Click OK. The message "Loading" appears. If the upload is 
successful, the message "CEDID Successfully Loaded" appears.  
In addition, the custom EDID file is added to the Select drop-down 
list.  

v. Continue with step 4b. 
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b. In the Select drop-down list, select the desired built-in or custom EDID. 
Click Save to save the EDID selection. 

To delete a custom EDID file, do the following in the EDID section of the page: 

NOTE:  Only custom EDID files can be deleted. Built-in EDID files cannot be deleted. 

1. In the Select drop-down list, select the custom EDID file to be deleted.  

2. Click the Delete button. 

The Input 1, Input 2, Input 3, and Input 4 pages also display information about the 
selected EDID and about the input signal: 

• The Current EDID section of the page displays the name of the current EDID.  
To view more details, click More Details. To view fewer details, click Fewer Details. 

• The Input Signal section of the page displays the following information: 

o Sync Detected:  Specifies whether a source is detected at the input: 

• A green icon indicates that a source is detected. 

• A gray icon indicates that a source is not detected.  

o Resolution:  Specifies the current resolution of the input signal 

o HDCP:  Specifies whether HDCP is active or inactive 

To view additional details about the input signal, click More Details. To view fewer 
details about the input signal, click Fewer Details. 

Configuring Output Settings 
The Output page allows resolution, underscan, and analog audio settings to be set for the 
HDMI and HDBT (HDBaseT) outputs. In addition, output settings and automatic power 
settings can be configured on an output-specific basis for the HDMI and HDBT outputs. 
Information about the connected display and output signal can also be viewed. 

Configuring Outputs on the Output Page 
To configure outputs on the Output page, do the following: 

1. In the navigation bar, click Output. The Output page opens.  

Output Page 

 

 



 

16  •  HD-WP-4K-401-C:  4K Multi-Window Video Processor Supplemental Guide – DOC. 7901B 

2. In the Output Settings section of the page, do the following: 

a. In the Resolution drop-down list, select the desired output resolution.  
The available selections are listed below.  

NOTE:  In the following list, RB denotes Reduced Blanking. 

Auto (Recommended)  1080p50   
640x480@60 1080p60  
480i 1920x1200@60 RB  
480p 2048x1080@24  
576i 2048x1152@60 RB  
576p 2048x1080@60 
800x600@60 1792x1344@60 
848x480@60 1856x1392@60 
1024x768@60 1920x1440@60 
720p@50 2048x1536@60 
720p@60 2560x1080@60 
1280x768@60 2560x1440@60 
1280x768@60 RB 2560x1600@60 RB 
1280x800@60 3840x2160@24 
1280x800@60 RB 3840x2160@25 
1280x960@60 3840x2160@30 
1280x1024@60 4096x2160@24 
1360x768@60 4096x2160@25 
1366x768@60 4096x2160@30 
1366x768@60 RB 1680x720@24  
1400x1050@60 1680x720@25 
1400x1050@60 RB 1680x720@30 
1440x900@60 1680x720@50 
1440x900@60 RB 1680x720@60 
1600x900@60 RB 2560x1080p24 
1600x1200@60 2560x1080p25 
1680x1050@60 2560x1080p30 
1680x1050@60 RB 2560x1080p50 
1080i50 2560x1080p60 
1080i60 
1080p24 

The default setting is Auto (Recommended), which specifies the preferred 
resolution of the connected display. If both the HDMI output and the HDBT 
output are connected, the resolution of the HDMI output takes precedence. 

b. In the Underscan drop-down list, select one of the following options to set the 
underscan mode, which reduces the image size by the specified percentage so 
that the entire video frame is displayed: 

• 0% (default setting) 

• 2.5% 

• 5% 

• 7.5% 

• Custom 
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If Custom is selected, enter a valid value in the Underscan text box. Valid 
values range from 0–10% in increments of 0.1%. To save the custom 
underscan setting, click the Set button. 

3. In the Analog Audio Settings section of the page, do the following: 

a. Mute or unmute the audio output by clicking the Volume button. By 
default, audio is unmuted and is set to 0 dB.  

b. If audio is unmuted, adjust the volume level as desired by dragging the 
Volume slider to the left or to the right. The volume decreases when the 
slider is dragged to the left and increases when the slider is dragged to the 
right. Available values range from -80 dB to 20 dB in increments of 0.5%.  

c. To set the audio delay so that the audio is in sync with the video, do either 
of the following: 

o Drag the Delay slider to the left or to the right. The Delay text box 
displays the value set by the Delay slider. 

o Enter the desired value in the Delay text box. Valid values range 
from 0 ms to 150 ms. The default setting is 0 ms. The Delay 
slider adjusts to the value entered in the Delay text box. 

The Output page also displays information about the connected display and output signal 
for both the HDMI and HDBT outputs: 

• The Connected Display section of the page displays the following: 

o Sink Detected:  Specifies whether the HDMI and HDBT signal is detected 
by the connected display (Yes or No) 

o Manufacturer:  Specifies the name of the manufacturer of the connected 
display 

o Name:  Specifies the model name of the connected display 

o Serial Number:  Specifies the serial number of the connected display 

• The Output Signal section of the page displays the following: 

o Transmitting:  Specifies whether the HDMI and HDBT outputs are 
transmitting a signal to the connected display: 

• A green icon indicates that the output is transmitting a signal. 

• A gray icon indicates that the output is not transmitting a signal. 

o Resolution:  Specifies the current resolution of the output 

o HDCP:  Specifies the HDCP version (1.4 or 2.2) or inactive 

Configuring Outputs on Output-Specific Pages 
The output-specific pages allow configuration of the HDMI output and the HDBT output on 
an individual basis. Output settings and automatic power settings can be configured for 
each output. In addition, information about the connected display and the output signal can 
be viewed. 

To configure HDMI output settings and to view information about the connected display and 
HDMI output signal, do the following:  In the navigation bar, click Output and then click 
HDMI Output.  The HDMI Output page opens. 
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HDMI Output Page 

 

To configure HDBT output settings and to view information about the connected display 
and HDBT output signal, do the following:  In the navigation bar, click Output and then click 
HDBT Output. The HDBT Output page opens. 

HDBT Output Page 

 

Refer to the following sections for HDMI and HDBT output configuration information. 
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Configuring HDMI or HDBT Output Settings 

In the HDMI Output Settings section of the HDMI Output page or the HDBT Output 
Settings section of the HDBT Output page, configure the output settings by doing the 
following: 

1. Enable or disable the output by selecting the Enable or Disable radio button, 
respectively. By default, the Enable radio button is selected, allowing the output 
display to turn on. If the Disable radio button is selected, the output display turns 
off. 

2. In the HDMI Name or HDBT Name text box, rename the output if desired. For the 
HDMI output, the default name is OUTPUT 1. For the HDBT output, the default 
name is OUTPUT 2. To save the new name, click the Save Name button.  

3. Select one of the following HDCP Mismatch radio buttons if the HDCP settings of 
one or more DigitalMedia devices in the signal path do not support the HDCP 
version of the source: 

• Blank Window:  (Default setting) Displays a blank window on the output if 
an HDCP mismatch exists 

• Disable Output:  Turns off the output if an HDCP mismatch exists 

Configuring Automatic Power Settings 

In the Automatic Power Settings section of the HDMI Output page or HDBT Output page, 
configure automatic power settings by doing the following: 

1. Enable or disable automatic power-off and power-on settings by selecting the 
Enable or Disable radio button, respectively. By default, the Enable radio button is 
selected. If Automatic Power Settings is set to Enable, continue with the following 
steps to configure automatic power settings: 

a. In the Power Off section, do the following: 

i. In the Timeout drop-down list, select the number of seconds that 
must pass after all HDMI inputs are disconnected before allowing the 
output to be turned off automatically. Available values are the 
following:  5 seconds, 10 seconds, 15 seconds, 30 seconds,  
60 seconds, 90 seconds, and Custom. The default setting is  
5 seconds. 

If Custom is selected, enter the desired number of seconds in the 
Timeout text box. Values range from 0 to 65535 seconds. To save 
the setting, click the Set button. 

ii. Specify whether the output is to be turned off according to the 
timeout value specified in the previous step. Select the Yes radio 
button to turn off the output or the No radio button to prevent the 
output from turning off.  
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iii. Select one of the Send command radio buttons to choose the 
interface to send a power-off command: 

• None:  (Default setting) Does not send any command 

• CEC:  Sends the command via CEC (Consumer Electronics 
Control) 

• RS232:  Sends the command via RS-232 

If RS232 is selected, click the RS232 setting button. In the 
RS232 Port Setting dialog box, select the desired value in the 
Baud, Data Bits, Parity, Stop Bits, Hardware Flow Control, 
and Software Flow Control drop-down lists, and then click 
Exit. 

iv. (Applicable only when Send command is set to CEC or RS232) 
Enter the desired power-off command as follows: 

• In the Command text box, enter the command in hexadecimal 
or ASCII format.  

• In the Terminator drop-down list, select one of the following 
terminators to append to the command:  None (specifies no 
terminator), CR (carriage return), LF (line feed), or CR LF 
(carriage return followed by a line feed). The default setting is 
CR LF. 

• Select the Hex or Ascii radio button to specify the format of 
the command. The default setting is Hex.  

v. Click the Save button to save the power-off settings. 

c. In the Power On (Sync Detected) section, do the following: 

i. Select one of the Send Command radio buttons to choose the 
interface to send a power-on command when an HDMI input is 
detected: 

• None:  Does not send any command (default setting)  

• CEC:  Sends the command via CEC 

• RS232:  Sends the command via RS-232 

If RS232 is selected, click the RS232 setting button. In the 
RS232 Port Setting dialog box, select the desired value in the 
Baud, Data Bits, Parity, Stop Bits, Hardware Flow Control, 
and Software Flow Control drop-down lists, and then click 
Exit. 

ii. (Applicable only when Send command is set to CEC or RS232) 
Enter the desired power-on command as follows: 

• In the Command text box, enter the command in hexadecimal 
or ASCII format.  

• In the Terminator drop-down list, select one of the following 
terminators to append to the command:  None (specifies no 
terminator), CR (carriage return), LF (line feed), or CR LF 
(carriage return followed by a line feed). The default setting is 
CR LF. 
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• Select the Hex or Ascii radio button to specify the format of 
the command. The default setting is Hex. 

iii. Click the Save button to save the power-on settings. 

The HDMI Output and HDBT Output pages also display information about the connected 
display and output signal: 

• The Connected Display section of the page displays the following: 

o Sink Detected:  Specifies whether the output signal is detected by the 
connected display (Yes or No) 

o Manufacturer:  Specifies the name of the manufacturer of the connected 
display 

o Name:  Specifies the model name of the connected display 

o Serial Number:  Specifies the serial number of the connected display 

• The Output Signal section of the page displays the following: 

o Transmitting:  Specifies whether the output is transmitting a signal to the 
connected display: 

• A green icon indicates that the output is transmitting a signal. 

• A gray icon indicates that the output is not transmitting a signal. 

o Resolution:  Specifies the current resolution of the output 

o HDCP:  Specifies the HDCP version (1.4 or 2.2) or inactive 

Configuring Network Settings 
To configure network settings, do the following: 

1. In the navigation bar, click Network. The Network page opens.  

Network Page 
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2. Configure network settings as required: 

• In the Host name text box, overwrite the existing hostname with a name 
that identifies the HD-WP-4K-401-C on the network. The hostname is 
restricted to the letters a to z (not case sensitive), the digits 0 to 9, and the 
hyphen. 

The default hostname is HDWP401C-xxxxxx, where xxxxxx consists of the 
last six characters (excluding punctuation) of the MAC address of the 
device. 

• In the Domain Name text box, enter up to two domain names separated 
by a comma and a space. 

• Specify whether the IP address of the HD-WP-4K-401-C is to be assigned 
by a DHCP (Dynamic Host Configuration Protocol) server. To set the IP 
address, click either of the following radio buttons: 

o Obtain an IP address automatically:  (Default setting) Allows the 
IP address of the HD-WP-4K 401-C to be automatically assigned 
by a DHCP server on the local area network (LAN) for a 
predetermined period of time. 

NOTE:  If a DHCP server does not exist on the network and  
45 seconds have elapsed since the HD-WP-4K-401-C was 
powered on, the IP address defaults to a link-local address. Refer 
to RFC 3927 for information about link-local addressing. 

o Use the following IP address:  Allows a static IP address and 
associated network settings to be configured: 

• IP Address:  Enter a unique IP address for the  
HD-WP-4K-401-C. 

• Subnet Mask:  Enter the subnet mask that is set on the 
network.  

• Default Gateway:  Enter the IP address that is to be used 
as the network’s gateway.  

• DNS Server1:  Enter the IP address of the primary DNS 
server. 

• DNS Server2:  Enter the IP address of the secondary 
DNS server. 

3. Do either of the following: 

• To save the current entries, click the Save button. The HD-WP-4K-401-C 
automatically reboots. 

• To go back to the previous settings without saving the current entries, click 
the Revert button.  
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Configuring Device Settings 
Configuration and management of device settings consist of the following: 

• Control system connection 

• Enabling or disabling the front panel 

• Changing the user name and password 

• Configuring RS232 port settings 

• Updating firmware 

• Restoring the factory default settings 

• Rebooting the HD-WP-4K 401-C 

To configure device settings, do the following:  In the navigation bar, click Device.  
The Device page opens. Refer to the following sections for information about configuration 
and management of the various device settings. 

Configuring Control System Connection Settings 
Configure the connection between the HD-WP-4K-401-C and a control system in the 
Control System Connection section of the Device page. 

Device Page—Sample Control System Connection 

 

To configure control system connection settings, do the following: 

1. In the Address or Host Name text box, enter the IP address or host name of the 
control system. 

2. In the IP ID text box, enter the IP ID of the HD-WP-4K-401-C. Valid values range 
from 03 to FE in hexadecimal notation.  

3. In the Port text box, enter the port number of the HD-WP-4K-401-C. 

NOTE:  The default port number is 41794. 

4. Do either of the following: 

• To save the current entries, click the Save button. A message appears, 
indicating that the HD-WP-4K-401-C will reboot. Click OK to reboot the 
device. 

• To revert to the previous settings without saving the current entries, click 
the Revert button. 

The Status field (read only) displays the connection status of the HD-WP-4K-401-C to the 
control system as Offline or Online.  
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Enabling or Disabling the Front Panel 
By default, the front panel state of the HD-WP-4K-401-C is enabled, allowing the OLED 
display and front panel push buttons (navigation pad, MENU, BACK, and EXIT) to function. 
In addition, the front panel LEDs are enabled by default. The OLED display, front panel push 
buttons, and LEDs can be disabled.  

NOTE:  For information about the OLED display and front panel push buttons, refer to 
"Using the Front Panel OLED Display Menu" on page 27. 

NOTE:  When the front panel LEDs are disabled, the PWR and ONLINE LEDs turn off.  
The HD-WP-4K-401-C appears as though it is not powered on; however, the device 
remains powered on and continues to function. 

Enable or disable the front panel state and LEDs in the Front Panel section of the Device 
page.  

Device Page—Front Panel 

 

Using the Front Panel State radio buttons, do either of the following: 

• To enable the OLED display and front panel push buttons, click the Enabled radio 
button if it is not already selected. 

• To disable the front panel, click the Disabled radio button. 

Using the Front Panel LEDs radio buttons, do either of the following: 

• To enable the front panel LEDs, click the Enabled radio button if it is not already 
selected. 

• To disable the front panel LEDs, click the Disabled radio button. 

Changing the Username and Password 
Change the username and password in the Username and Password section of the 
Device page.  

Device Page—Username and Password 

 

To change the username and password, do the following: 

NOTE:  The username and password are case sensitive. 
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1. In the Username text box, enter the desired username. 

2. In the Password text box, enter the desired password. 

3. In the Confirm Password text box, reenter the desired password to confirm the 
password. 

4. Do either of the following:  

• To save the current entries, click the Save button.  

• To go back to the previous settings without saving the current entries, click 
the Revert button. 

Configuring RS232 Port Settings 
Configure RS232 port settings in the RS232 Port Settings section of the Device page.  

Device Page—RS232 Port Settings 

 

To configure RS232 port settings, do the following: 

1. In the Baud drop-down list, select the number of bits to be transmitted per second. 
Available values are as follows: 

300  9600 
600  14400 
1200 19200 
1800 28800 
2400 38400 
3600 57600 
4800 115200 
7200  

 The default setting is 9600 bits per second (bps). 

2. In the Data Bits drop-down list, select the number of data bits that are to be 
transmitted as a series. Available values are 7 and 8. The default setting is 8. 

3. In the Parity drop-down list, select NONE, Odd, Even, or Mark. The default setting 
is NONE. 

4. In the Stop Bits drop-down list, select 1 or 2. The default setting is 1. 

5. In the Hardware Flow Control drop-down list, select RTS/CTS or NONE.  
The default setting is NONE. 

6. In the Software Flow Control drop-down list, select NONE or XON/XOFF.   
The default setting is NONE. 
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Updating Firmware 
Update firmware in the Firmware section of the Device page. 

Device Page—Firmware 

 

The Firmware section displays the following information about the HD-WP-4K-401-C: 

• Model, which is HD-WP-4K-401-C  

• Serial Number 

• Firmware Version 

To update the firmware, click the Upload firmware file radio button or the Use service port 
radio button: 

• If the Upload firmware file radio button is selected, do the following: 

1. Click the Browse button. Windows Explorer opens. 

2. Locate and select the desired firmware file (*.bin), and then click the Open 
button. The Browse field displays the selected path and firmware filename.  

3. Click the Load button. A prompt appears asking for confirmation that the 
firmware be updated. 

4. Click the OK button to update the firmware. 

• If the Use service port radio button is selected, do the following: 

1. Using a USB mass storage device that contains only the firmware file, 
insert the USB device into the SERVICE port of the HD-WP-4K-401-C. 

2. Click the Load button. A prompt appears asking that a USB drive be 
inserted. 

3. Click the OK button to update the firmware. 

Restoring Factory Default Settings 
Restore factory default settings in the Device Management section of the Device page. 

Device Page—Device Management, Restore 
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To restore factory default settings, do the following: 

1. Click the Restore button. A prompt appears asking for confirmation that the default 
settings be restored. 

NOTE:  Clicking the Restore button restores all settings—including the user name 
and password login settings and the network settings—to the factory default 
settings. If the user name and password have been changed, clicking the Restore 
button reverts the user name and password to the default setting, which is admin 
(refer to "Logging In to the HD-WP-4K-401-C" on page 4). If a static IP address has 
been set, clicking the Restore button reverts the IP address to DHCP mode, which 
is the default setting (refer to "Configuring Network Settings" on page 21).    

2. Click OK to restore factory default settings and to reboot the device.  

Rebooting the HD-WP-4K-401-C 
Reboot the HD-WP-4K-401-C in the Device Management section of the Device page. 

Device Page—Device Management, Reboot 

 

To reboot the HD-WP-4K-401-C, do the following: 

1. Click the Reboot button. A message appears, indicating that the device will reboot.  

2. Click OK to reboot the device. 

Using the Front Panel OLED Display Menu 
When the HD-WP-4K-401-C is powered on and whenever the front panel OLED display is 
in an idle state, the OLED display cycles through the following items on a scrolling basis, 
displaying two lines at a time: 

HD-WP-4K-401-C 
IP address (for example, 172.30.161.59) 
1. Input 1 resolution (for example, 3840x2160@30) 
2. Input 2 resolution (for example, 1080p@60) 
3. Input 3 resolution (for example, 1080p@60) 
4. Input 4 resolution (for example, 720p@60) 

NOTE:  If a source is not connected to an input, the OLED displays None for the input. 

The OLED display provides a menu that allows configuration of the HD-WP-4K-401-C.  
The following illustration provides a menu tree of the OLED display. 
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OLED Display Menu Tree 

 

The following sections provide information about the OLED display menu. 

Accessing and Navigating the OLED Display Menu 
To access and navigate the OLED display menu, use the OLED push buttons and the 
navigation pad on the front panel of the HD-WP-4K-401-C.  

OLED Push Buttons and Navigation Pad 

 

To access the main menu of the OLED display, press the MENU button. The OLED main 
menu, which displays two lines at a time, appears as follows. 

OLED Main Menu 

<< Main Menu >> 
Windowing 

  

Global EDID
Input 1
Input 2
Input 3
Input 4

Main Menu

Inputs

Output 1
Output 2

Outputs

Status
DHCP
DHCP Renew (Displayed only if DHCP is ON)
IP Setup (Displayed only if DHCP is OFF)
DNS Server 1
DNS Server 2

Network

Details
Front Panel
Firmware Update
Restore

Device

Layout
Window Titles

Windowing
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To navigate the main menu and submenus on the OLED display, do the following: 

• To navigate upward in a menu, press the up button () on the navigation pad. 

• To navigate downward in a menu, press the down button () on the navigation 
pad. 

• To move the cursor to the left when entering data, press the left button () on the 
navigation pad. 

• To move the cursor to the right when entering data, press the right button () on 
the navigation pad. 

• To select an item in a menu, press the Enter button on the navigation pad. 

• To save a new setting, press the Enter button on the navigation pad. 

• To go back to the previous level in a menu, press the BACK button on the front 
panel. 

• To exit the menu of the OLED display, press the EXIT button on the front panel.  

Configuring Windowing Settings  
To configure video windowing settings, do the following:  On the main menu, select 
Windowing. The Windowing submenu opens. 

Windowing Submenu 

< Windowing > 
Layout 

Available selections are as follows: 

Layout 
Window Titles 

Refer to the following sections for information about configuring video window layout and 
window titles. 

Configuring Video Window Layout 
To configure the video window layout, do the following: 

1. In the Windowing submenu, select Layout.  

Windowing Submenu 

< Windowing > 
Layout 

The Layout submenu opens. 

Layout Submenu 

< Layout > 
Layout Select 
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2. Select Layout Select. The Layout Select list of available options opens. 

Layout Select Submenu 

< Layout Select> 
*Auto 

Available Layout Select options are listed in the following table. Refer to the table for 
information about each option. 

Layout Select Options 

OPTION DESCRIPTION 

Auto (Default setting) Displays the detected inputs as follows:  
• Displays four detected inputs as a quad view consisting of four 

equal-sized windows (two side-by-side windows above two  
side-by-side windows)  

• Displays three detected inputs as three equal-sized windows  
(two side-by-side windows above one centered window)  

• Displays two detected inputs as two equal-sized and vertically 
centered windows 

• Displays one detected input as a full-screen image  

Full Screen Displays one detected input as a full-screen image 

PIP Displays any single input as a full-screen image with any other input as a 
scalable inset window that can be positioned as desired (refer to 
"Configuring Window Titles" on page 31 for information about PIP options) 

Side by Side Displays any two inputs as two equal-sized and vertically centered windows 

Quad View Displays four inputs as four equal-sized windows (two side-by-side 
windows above two side-by-side windows) 

An asterisk precedes the current setting. If Full Screen, PIP, Side by Side, or 
Quad View is selected, the corresponding number of windows is added to the 
Layout submenu: 

• If Full Screen is selected, Window 1 is added to the Layout submenu 
below Layout Select. 

• If PIP or Side by Side is selected, Window 1 and Window 2 are added to 
the Layout submenu below Layout Select. 

• If Quad View is selected, Window 1, Window 2, Window 3, and  
Window 4 are added to the Layout submenu below Layout Select. 

3. For Full Screen, PIP, Side by Side, and Quad View layout selections, assign each 
corresponding window to the desired video input by doing the following: 

a. In the Layout submenu, select the window, for example, Window 1. 

Layout Submenu 

< Layout > 
Window 1 

The Window submenu opens for the selected window, for example, 
Window 1. 
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Window Submenu (Window 1 Shown) 

< Window 1 > 
INPUT 1 

b. Select the desired video input for the window. By default, the inputs are 
listed as INPUT 1, INPUT 2, INPUT 3, and INPUT 4. 

c. Repeat steps 3a and 3b for each window listed in the Layout submenu. 

Configuring Window Titles 
To configure window titles, do the following:  In the Windowing submenu, select Window 
Titles.  

Windowing Submenu 

< Windowing > 
Window Titles 

The Window Titles submenu opens. 

Window Titles Submenu 

< Window Titles > 
Window Titles 

Items on the Window Titles submenu are listed in the following table. Refer to the table for 
configuration guidelines. 

Window Titles Submenu Guidelines 

SUBMENU 
ITEM 

 
GUIDELINES 

Window Titles Controls whether the input name is to be displayed over the corresponding 
window: 

• Enable:  (Default setting) Allows window titles, which display the input 
name over the corresponding window 

• Disable:  Prevents the input name from being displayed over the 
corresponding window 

An asterisk precedes the current setting. 

Titles Position (Applicable only when Window Titles is enabled) Select one of the following 
options to position window titles: Upper Left (default setting), Center Left, 
Lower Left, Upper Right, Center Right, Lower Right. An asterisk precedes 
the current setting. 
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Configuring Input Settings 
To configure input settings, do the following: 

1. On the main menu, select Inputs. The Inputs submenu opens. 

Inputs Submenu 

< Inputs > 
Global EDID 

Available selections are as follows: 

Global EDID 
Input 1 
Input 2 
Input 3 
Input 4 

2. Configure inputs as follows: 

a. (Optional) Select Global EDID. 

The following message flashes across the OLED: Apply EDID to All Inputs 

i. Confirm the Global EDID selection by pressing the Enter button. A 
list of EDID files is presented. 

DM Default 4k 30Hz 2ch (Default setting)  
DM Default 1080p60 2ch 
Laptop 16x10 1280x800 2ch 
Laptop 16x10 1920x1200 2ch 
Laptop 16x9 1080P50 2ch 
Laptop 16x9 1080P60 2ch 
Laptop widescreen 2ch 
Consumer 4k 25Hz HBR 3D 
Consumer 4k 30Hz HBR 3D 
Consumer 1080P50 3D HBR 
Consumer 1080P50 HBR 
Consumer 1080P60 3D HBR 
Consumer 1080P60 HBR 
Consumer 720P50 HBR 
Consumer 720P60 HBR 
External EDID 1   
External EDID 2 
External EDID 3 
External EDID 4 
External EDID 5 
External EDID 6 
External EDID 7 
External EDID 8 
Copy Output 1 
Copy Output 2 
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NOTE:  In the preceding list, External EDID 1 through External  
EDID 8 represent placeholders for custom-loaded EDID files. 

NOTE:  Selecting Copy Output 1 or Copy Output 2 copies the 
EDID from the output to all of the inputs. 

ii. Select the desired EDID.  

A prompt appears asking for confirmation that the selected EDID 
be applied to all inputs. 

iii. Select Yes or No: 

• If Yes is selected, the Setting message appears, and then 
the OLED display returns to the Inputs submenu. 

• If No is selected, the OLED display returns to the list of 
available EDIDs. 

b. Configure each input on an individual basis by selecting the input number 
in the Inputs submenu. 

The Input Status and Configuration submenu opens for the selected input. 

Input Status and Configuration Submenu (Input 1 Shown) 

< Input 1 > 
Status 

Items on the Input Status and Configuration submenu are listed in the 
following table. Refer to the table for configuration guidelines. 

Input Status and Configuration Submenu Guidelines 

SUBMENU 
ITEM 

 
GUIDELINES 

Status (Read Only) Indicates whether a source is detected at the input: 
Sync On or Sync Off 

Name Allows renaming of an input. To rename an input, use the up ()  
and down () buttons to enter capital letters, lowercase letters, 
numbers, a plus sign (+), a minus sign (-), a left bracket ([), and a 
right bracket (]). To move the cursor to the left or right when 
renaming an input, press the left () or right () button, respectively. 
To save the name, press the Enter button. The message Saving… 
Complete is displayed. 

  (Continued on following page) 
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Input Status and Configuration Submenu Guidelines (Continued) 

SUBMENU 
ITEM 

 
GUIDELINES 

EDID Displays the current EDID. If an EDID other than the Global EDID is 
to be assigned, select the desired EDID. Available selections are as 
follows: 

DM Default 4k 30Hz 2ch (Default setting)  
DM Default 1080p60 2ch 
Laptop 16x10 1280x800 2ch 
Laptop 16x10 1920x1200 2ch 
Laptop 16x9 1080P50 2ch 
Laptop 16x9 1080P60 2ch 
Laptop widescreen 2ch 
Consumer 4k 25Hz HBR 3D 
Consumer 4k 30Hz HBR 3D 
Consumer 1080P50 3D HBR 
Consumer 1080P50 HBR 
Consumer 1080P60 3D HBR 
Consumer 1080P60 HBR 
Consumer 720P50 HBR 
Consumer 720P60 HBR 
External EDID 1   
External EDID 2 
External EDID 3 
External EDID 4 
External EDID 5 
External EDID 6 
External EDID 7 
External EDID 8 
Copy Output 1 
Copy Output 2 

When an EDID is selected, the Setting message is displayed. 
NOTE:  In the list above, External EDID 1 through External  
EDID 8 represent placeholders for custom-loaded EDID files. 
NOTE:  Selecting Copy Output 1 or Copy Output 2 copies the 
EDID from the output to all of the inputs. 

HDCP Assigns the HDCP version or disables HDCP. Select HDCP 2.2,  
HDCP 1.4, or Disable.  The default setting is HDCP 2.2.  
An asterisk precedes the current setting. 
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Configuring Output Settings 
To configure output settings, do the following: 

1. On the main menu, select Outputs. The Outputs submenu opens. 

Outputs Submenu 

< Outputs > 
Output 1 

Available selections are Output 1 and Output 2. 

2. Configure an output by selecting the output in the Outputs submenu. The Output 
Configuration submenu opens for the selected output. 

Output Configuration Submenu (Output 1 Shown) 

< Output 1 > 
Status 

Items on the Output Configuration submenu are listed in the following table.  
Refer to the table for configuration guidelines. 

Output Configuration Submenu Guidelines 

SUBMENU 
ITEM 

 
GUIDELINES 

Status (Read Only) Displays the manufacturer, model, and serial number of 
the connected display. If no display is connected, the status is 
displayed as Inactive. 

Name Allows renaming of an output. To rename an output, use the up () 
and down () buttons to enter capital letters, lowercase letters, 
numbers, a plus sign (+), a minus sign (-), a left bracket ([), and a 
right bracket (]). To move the cursor to the left or right when 
renaming an output, press the left () or right () button, 
respectively. To save the name, press the Enter button.  
The message Saving…Complete is displayed. 

Configuring Network Settings 
To configure network settings, do the following: On the main menu, select Network.  
The Network Status and Configuration submenu opens. 

Network Status and Configuration Submenu 

< Network > 
Status 

Available selections are as follows: 

Status 
DHCP 
DHCP Renew (Displayed only if DHCP is set to ON) 
IP Setup (Displayed only if DHCP is set to OFF) 
DNS Server 1 
DNS Server 2 

Items on the Network Status and Configuration submenu are listed in the following table. 
Refer to the table for configuration guidelines. 
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Network Status and Configuration Submenu Guidelines 

SUBMENU 
ITEM 

 
GUIDELINES 

Status (Read Only) Provides the following network-related information: 
• DHCP:  Indicates whether DHCP is on or off 
• IP Address:  Displays the IP address of the HD-WP-4K-401-C 
• Subnet Mask:  Displays the subnet mask that is set on the network 
• Gateway:  Displays the IP address that is used as the network’s 

gateway 
• DNS Server 1:  Displays the address of the primary DNS server 
• DNS Server 2:  Displays the address of the secondary DNS server 
• MAC Address:  Displays the MAC address of the HD-WP-4K-401-C 

DHCP Set DHCP to ON or OFF. The default setting is ON. An asterisk precedes the 
current setting. 

DHCP Renew (Displayed only if DHCP is set to ON) Select DHCP Renew to obtain a new IP 
address lease.  

IP Setup (Displayed only if DHCP is set to OFF) Enter the following network-related 
information: 

• IP Address:  Enter a unique IP address for the HD-WP-4K-401-C. 
• Subnet Mask:  Enter the subnet mask that is set on the network. 
• Gateway:  Enter the IP address that is used as the network’s 

gateway 
To enter an address, use the navigation pad. Press the up () and down () 
buttons as appropriate to enter each octet in an address. To move to the 
previous octet in an address, press the left () button. To move to the next 
octet in an address, press the right () button. To save an address, press the 
Enter button. 

DNS Server 1 Enter the address of the primary DNS server. To enter an address, use the 
navigation pad. Press the up () and down () buttons as appropriate to enter 
each octet in an address. To move to the previous octet in an address, press 
the left () button. To move to the next octet in an address, press the right () 
button. To save an address, press the Enter button.  

DNS Server 2 Enter the address of the secondary DNS server. To enter an address, use the 
navigation pad. Press the up () and down () buttons as appropriate to enter 
each octet in an address. To move to the previous octet in an address, press 
the left () button. To move to the next octet in an address, press the right () 
button. To save an address, press the Enter button. 

Configuring Device Settings 
To configure device settings, do the following: On the main menu, select Device.  
The Device Status and Configuration submenu opens. 

Device Status and Configuration Submenu 

< Device > 
Details 

  



 

Supplemental Guide – DOC. 7901B HD-WP-4K-401-C:  4K Multi-Window Video Processor •  37 

Available selections are as follows: 

Details 
Front Panel 
Firmware Update 
Restore 

Items on the Device Status and Configuration submenu are listed in the following table. 
Refer to the table for configuration guidelines. 

Device Status and Configuration Submenu Guidelines 

SUBMENU 
ITEM 

 
GUIDELINES 

Details (Read Only) Display the following information about the HD-WP-4K-401-C: 
• S/N:  Specifies the serial number of the HD-WP-4K-401-C 
• FW Ver.:  Specifies the firmware version of the HD-WP-4K-401-C 

Front Panel Selecting Disable disables the OLED display and front panel push buttons 
(navigation pad, BACK, and EXIT buttons). 
NOTE:  To enable the OLED display and front panel push buttons, press and 
hold the MENU push button for 3 seconds. 

Firmware Update When Firmware Update is selected, a prompt appears asking for confirmation 
that the firmware be updated. Select Yes or No. If Yes is selected, insert a 
USB mass storage device containing the updated firmware file into the 
SERVICE port if the device is not already inserted. The update process begins 
and the following message appears on the OLED display:  

Upgrade in process 
Do not remove power 

When the update process is complete, the OLED displays the model name 
(HD-WP-4K-401-C) and the IP address of the HD-WP-4K-401-C. 

Restore When Restore is selected, a prompt appears asking for confirmation that the 
default settings be restored.  
NOTE:  Restoring the HD-WP-4K-401-C to factory default settings restores all 
settings—including the user name and password settings and the network 
settings—to the factory default settings.  
Select Yes or No. If Yes is selected, the Restoring message appears followed 
by the Restoring…Complete message. 
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